An introduction to OpenCms
Version 5.0

This document contains introductory material about OpenCms. Learn how to create web pages with OpenCms using the OpenCms workplace and the WYSIWYG editor. The full 5.0 documentation is available on the OpenCms website.

www.opencms.org
# Contents

1 OpenCms User Manual ................................................. 1
  1.1 Introduction ................................................... 1
    1.1.1 What is OpenCms? ........................................ 1
    1.1.2 The advantages of OpenCms ............................ 1
    1.1.3 Configuring the client ................................. 1
  1.2 Section 1: OpenCms - The demo ............................. 3
    1.2.1 Editing a website ....................................... 3
    1.2.2 Creating a new page .................................... 10
  1.3 Section 2: OpenCms - The mechanics ..................... 14
    1.3.1 The user interface .................................... 14
    1.3.2 View Modes ............................................. 14
    1.3.3 Working on a project .................................. 15
    1.3.4 Access permissions .................................... 20
    1.3.5 The editor ............................................... 22
    1.3.6 Workflow ............................................... 22
1 OpenCms User Manual

1.1 Introduction

1.1.1 What is OpenCms?

OpenCms 5 is a Content Management System that is based on Open Source Software. Complex Intranet and Internet websites can be quickly and cost-effectively created, maintained and managed.

OpenCms enables you to create complete websites offline that are published when you’re satisfied with the results. An offline project enables several users with different permissions to work on the offline version as a team. OpenCms enables you to easily coordinate users that are writing, designing or managing content. It also enables you to manage the project’s workflows.

Once it has been completed and approved, the offline version is published by the project manager. Subsequent modifications and maintenance activities are performed offline. The site is updated by replacing the online files with the files that were modified offline.

1.1.2 The advantages of OpenCms

OpenCms is platform independent. The software used to create the website is installed on a web server and is accessed via the Internet from any location such as your home. Users use their web Browser to access OpenCms via the Internet. The combination of their user name and password ensures that their work environment remains protected. All of the web server’s software components are based on Java technology.

1.1.3 Configuring the client

Netscape Navigator or Microsoft Internet Explorer must be installed on the client. You should use IE 5.5 or higher or Netscape Navigator 7.0 or higher. Configuration details for each of the Browsers can be found in chapter ??.

We divided the user’s guide, which explains how to use the system’s most important functions, into two sections: Section 1 consists of a demo that is intended to give you a practical
introduction to OpenCms; Section 2 describes the individual functions of OpenCms more
detailed.

**NOTE:** Our explanations are based on the assumption that OpenCms has been success-
fully installed and is running on your web server or local computer.
1.2 Section 1: OpenCms - The demo

The following demo is based on a real life scenario and was designed to get you up and running as quickly as possible. The module `org.opencms.welcome` must be present in your OpenCms system (it is installed per default by the OpenCms setup).

Open your Internet browser and enter http://localhost:8080/opencms/opencms/ to access the OpenCms welcome site.

The OpenCms site welcome page is displayed (Figure 1.1). The navigator on top contains the links to all of the pages. Click on "Release notes".

The release notes page is displayed. The first section of the demo consists of modifying this page in OpenCms by following the instructions described below.

---

1.2.1 Editing a website

Activate the "Workplace" to edit a page in OpenCms. The "Workplace" is the OpenCms user interface that is used to change, delete and create new pages. The "Workplace" is entirely based on HTML, which is why you don’t have to install additional software to run it from your Internet browser.

Enter the following address in your browser to start the "Workplace:"

http://localhost:8080/opencms/opencms/system/login/

---

Figure 1.1: Welcome page
CHAPTER 1. OPENCMS USER MANUAL

Logging into the system

In the login dialog box (Figure 1.2), enter "Admin" as the user name and "admin" as the password.

![Login dialog box](image)

Figure 1.2: "Login" dialog box

Logging in automatically opens a new browser window and closes the old one (you will be prompted to confirm this action). You are now in the “Workplace,” in the so-called “Explorer” view (Figure 1.3). This is where the actual editing starts.

![ Explorer view](image)

Figure 1.3: Explorer view

**NOTE:** OpenCms is a project based application, which means that you cannot modify the pages online. You first have to create an editing (offline) project. The default “Offline” project can also be used for editing pages.
Creating a new project

Switch to the administration window by clicking on “View” on the menu bar and selecting “Administration” from the drop-down menu (Figure 1.4).

The Administration view is opened. The following buttons are displayed: (Figure 1.5):

Click on “Project Management.” A new page is opened that contains the following buttons (Figure 1.6):

Click on “New Project” to create a new project.

The dialog window “Create a new project” is opened (Figure 1.7). Enter the project data:

- Project name: Nice try
• Description: Create test project

• Folders: /release/

• Channels: [leave empty]

• User group: Users

• Manager group: Project manager

Click on the "OK" button.

NOTE: Clicking on the folder icon next to the “Directories” field opens a second window that contains a list of the existing directories. Here you can select other directories for your new project. The window closes automatically.
Switch back to the Explorer view by selecting it from the “View” drop-down menu. Select the “/release/” directory (the same one you selected when creating your project) from the drop-down menu. The Explorer view is opened. Open your “Nice try” project by selecting it from the Project drop-down menu on the menu bar (Figure 1.8).

![Image of Explorer view](image)

Figure 1.8: "Project" view

The view for your project is open. You can now edit any one of its pages.

**NOTE:** You have surely noticed that all of the folders in the folder tree are inactive except for “/release/”, “/system/galleries/download/”, “/system/galleries/pics/”, “/system/galleries/externallinks/”, “/system/galleries/htmlgalleries/” and “/system/bodies/”. Once the project is selected, OpenCms only allows you to modify files in your project directories.

**Editing pages**

A page must be locked for all other users before it can be opened. Click on the icon next to the text "installation.html" with the left mouse button to display the context-sensitive menu (Figure 1.9). Click on the menu item “Lock.”

An open lock is displayed next to your locked file. Should the icon not appear, check your browser settings (see above) or refresh the view with the button .

Click on the icon next to the text "installation.html" with the left mouse button again to display the context-sensitive menu. Click on "Edit page" to open the HTML editor.

**Working with the HTML editor**

You are now in the OpenCms HTML editor (Figure 1.10). Here you will find a number of editing icons that should be familiar from other applications, such as Open Office or Word.

In the text editor, which is just below the icons, the text that you saw at the release notes page is displayed. Make changes to the text and its format (e.g. bold, italics, underline).
By the way: The HTML editor view you are currently in is a WYSIWYG view ("What you see is what you get"); this means that pages are displayed here exactly as they will be seen later on the Internet.

The "Template" drop-down menu is on the right part of the menu bar (Figure 1.11). Select one of the pre-defined page structures and layouts. You will see the changes by clicking
on the "preview" button in the upper right corner of the editor.

![Drop-down menu "Template"

In the upper menu bar is the "Editor" drop-down menu, which contains a selection of Editor views. You are currently in the WYSIWYG view. Select the “Sourcecode editor” view. The view is opened and displays the same content as source code. Close the view by clicking on the button “Save & Exit”, which is at the far left of the menu bar.

The Explorer view is displayed.

Completing the editing phase

The page’s details are currently displayed in red, which means that the page has been edited. Additionally there is a little red flag, which means that this page was locked and changed in the current project. Click on the page icon of “installation.html” with the left mouse to “unlock” it. Click on the menu item “Unlock” in the context-sensitive menu to unlock the page. The lock disappears (Figure 1.12).

Publishing a project

Open the “Administration” view. Click on the “Project management” button and after that on “Current projects.” The project you just edited is displayed in the overview. Click on the project’s icon to access the context-sensitive menu. Select the menu item "Publish" (Figure 1.13). Click on "OK."

Note: You can also publish the current project by clicking on the icon between the project selector and the view selector on top of the OpenCms workplace.

Start the demo application again:

The test page is displayed with your modifications (Figure 1.14).
1.2.2 Creating a new page

You can add new pages and folders for your web page from the Explorer view. Create a new project or select the “Nice try” project by following the steps described above. Go to the “/release/” directory by clicking on the appropriate folder in the directory tree with the left mouse button.

Click on the “new” icon . The dialog window “New” is opened (Figure 1.15).

Click on the radio button “Page.”

Click on the “Continue” button. Enter the following data in the dialog window “Create a new page” (Figure 1.16):

- Name: help
- Title: Test page
My first modification

Installation of OpenCms 5.0

This page provides information on how to install OpenCms using Tomcat and MySql. All installation parts are described as single steps. After completing each step, you are strongly advised to verify the success.

1. Install the Java JDK

Install Java JDK 1.4 or later (from SUN http://java.sun.com/products/jdk/). For details on how to install Java on your operating system, see the documentation that comes with it.

Important: This version of OpenCms was tested with Java 1.4 only. Some features regarding file encoding where used that are not available with Java releases before 1.4.

2. Install Tomcat

OpenCms 5.0 requires a Servlet 2.3 / JSP 1.2 standards compliant container. Tomcat 4 is the reference implementation of this Standard. This release was tested with Tomcat 4.0.x and Tomcat 4.1.x. Older versions of Tomcat (3.x and earlier) do not support this newer standard and are thus not usable for OpenCms 5.0.

Install Tomcat from http://jakarta.apache.org/tomcat/index.html into a folder of your choice. This is the CATALINA_BASE folder. Don’t forget to set the environment variables CATALINA_HOME and JAVA_HOME.

Text the installation by running Tomcat in standalone mode and check the examples. Note: Tomcat uses port 8080 in standalone mode. If you wish, you can combine the port rights with a webserver like the Apache Web Server http://www.apache.org/httpd.html . Please see the documentation available with the webserver on how to combine it with your servlet environment.

Important: To make sure Tomcat works with the correct charset to read and write files you should add the following parameter to the commandline that is used to start Tomcat: -Dfile.encoding=utf-8. You can set the environment variable CATALINA_BASE\_BLUEPRINT_FILE_ENCODING=ISO-8859-1. The default encoding of OpenCms is ISO-8859-1, but you can also set another encoding supported by your Java VM, e.g. UTF-8. In case you do not care about the encoding, the default is most likely what you need.

3. Install MySQl.

---

Figure 1.14: Modified installation page

![Modified installation page](image1.png)

Figure 1.15: Dialog window “New”

- Template: Welcome / Release notes template
- Keywords: Here you can enter some keywords
- Description: Here you can enter a description
- (Checkbox) add to navigation: check (default)
- Text in Navigation: Help
NOTE: The “Text in navigation” is the name that will later be displayed as the link in the online navigator.

Click on “Finish”. This takes you back to the Explorer view and displays the details of your new page in blue with a lock (Figure 1.17). You can either continue editing the page (see above) or use the context-sensitive menu to unlock it for other users.

Figure 1.17: Explorer view with new page

Publish the project as explained under “Publishing a project” and open the installation page:
http://localhost:8080/opencms/opencms/release/installation.html
The installation page is displayed with the new link to your page “help.html” in the top navigation. Click on the link to view your new page (Figure 1.18).

This is the end of our short demo. Thank you for your attention. Additional and more detailed information about OpenCms is described in section 2 of the guide.
1.3 Section 2: OpenCms - The mechanics

1.3.1 The user interface

The user interface is customized by clicking on the “Settings” tab (the “hammer” button on the menu bar):

- The additional file information that is to be displayed in the Explorer view is defined on the “Explorer” tab.
- The Standard view and messaging options for task management are defined on the “Tasks” tab.
- The user’s default startup settings and permissions for new files are defined on the “Startup Options” tab.
- A user’s group and password are changed on the “User Data” tab.

1.3.2 View Modes

The user screen contains all of the components, grouped in views, that enable users to create, maintain and manage web pages. In the “Explorer” view, users manage directories and files and edit HTML pages. A project’s workflow is managed in the “Tasks” view. Users, groups, projects, database connections, images, documents etc. are managed in the “Administration” view. The user screen (default startup view) is started via a login dialog and is displayed as a file explorer. The directory tree structure, the file view and the menu bar make it easy for users to access files and functions (Figure 1.19): Users can switch between the online version of the web page and the individual offline projects by selecting one of the options in the “Project” drop-down menu.

Users can switch between the “Explorer”, “Tasks” and “Administration” views by selecting one of the options in the “View” drop-down menu.

The files and directories are managed via a context-sensitive menu that is activated by clicking on the file or directory icon in the file overview.

The content of the website as it will be seen online is displayed in the browser screen (Figure 1.20). The website’s files and directories cannot be modified in the online version. The browser screen, which displays the page as it would be seen by someone visiting the live site, is activated by clicking on the file name in the “Explorer” view:

- The Template of an OpenCms-generated browser page contains the static and dynamic navigation components as well as other dynamic components such as logos or text fields that can be freely defined. The template determines the page’s layout.
The content is displayed in the Body. Content is freely defined. Its layout is based on previously defined format templates. The format templates ensure that the content is uniformly displayed.

1.3.3 Working on a project

An offline project is created by a user that belongs to the "Project manager" group. The project can be created for an existing website that needs updating or a brand new website.

When you create an offline project for an existing website a view on the offline resources for this website is created. When the modified pages are published, the changes are copied to the online project. Additionally the changed resources are stored in backup tables for traceability purposes.

By default, an offline project’s files and directories can only be modified by the project members. Responsibilities are clearly defined by assigning specific users and groups to specific files and directories. It is also possible to process part of the web site in different projects at the same time. Locking and unlocking functions ensure that access security remains intact for larger user groups.

The modifications that are made to the files are written to a backup table after publishing. The information about all versions can be accessed via the “History” option in the context-sensitive menu (Figure 1.21).

To create new content, the user creates a new file or directory by clicking on the “New” button on the menu bar. This opens a dialog window in which the user selects the element to create: “Folder,” “Page,” “Link”, “Text”, “XMLTemplate”, “JSP” or “Upload new file.”
The name, title and navigation text as well as the position of the file or directory in the
navigation, are defined in separate dialog boxes. Selecting the option “Upload new file” enables users to load files that are stored on their PC’s local hard disks into an OpenCms directory. Users access their assigned directories and files via the file “Explorer” view of OpenCms.

Clicking on the directory name (e.g. “OpenCms”) in the directory tree structure or in the “Explorer” view displays the directory’s contents. Clicking on an HTML file name (e.g. “index.html”) opens a preview of the file in the Internet browser. Clicking on a directory or file icon (text file, image etc.) in the file overview displays a context-sensitive menu. The menu contains the following functions that are accessible (active/inactive) based on the file’s or directory’s status and the user’s access permissions:

- **Lock or Unlock**: Directories or files can be locked throughout the editing phase to prevent them from being accessed or modified by several users at the same time. A file or directory is unlocked when the user has finished modifying it.

- **Publish directly**: A single resource can be published directly. This item is enabled when a changed file is unlocked.

- **Edit page**: Clicking opens a WYSIWYG editor in which the file can be modified. At this stage, no HTML knowledge is required to modify a page.

- **Edit sourcecode**: Clicking opens a text editor in which the file can be modified. This requires at least basic HTML knowledge to modify a page.

- **Edit control code**: Clicking opens a text editor in which control codes can be edited. **Warning**: Extensive knowledge of the OpenCms template mechanism is required to make modifications of this type.

- **History**: The history file displays all of the file’s previous versions. The history file enables users to see who made which modifications when. When the file is locked a button for restoring a version is shown in the “Detail” of the version.

- The respective access attributes for the individual files and directories are set on the system side by using the functions “Change owner”, “Change group” and “Change permissions”.

- **Change navigation**: Here the navigation text and position of a resource can be changed.

- **Properties**: To every resource properties can be attached as key / value pairs, e.g. the title or the description is stored as a resource property. Properties can be added, modified or deleted.

- Standard functions such as “Copy”, “Rename”, “Move” and “Delete” can be selected from the context menus. “Touch” changes the timestamp of a resource, which marks it as changed, and it will be published when the project is published.
• **Undelete resources**: When a resource that already exists in the online project is deleted it is marked by crossing out its entry in the file list. Now it is possible to undelete these resources. When undeleting a folder all subresources in this folder that were marked as deleted are undeleted, too. You must have write access to undelete a resource.

![Figure 1.22: Undelete a resource](image)

After the resource is undeleted its state is set to changed and the resource is locked by the current user.

• **Undo changes**

Changes of a resource can be undone. The resource must be marked as changed and it must be locked. You must have write access to the resource. When the changes of a folder are undone all changes of subresources are undone, too. This feature copies the information from the online project, so all changes that were not published yet are lost and new resources are deleted.

![Figure 1.23: Undo changes of a resource](image)
• **Restore a version from history**

Older versions of a file can be restored from the history. The file must be locked. This feature currently works only for files, not for folders. The function is only enabled for locked files. It is implemented in the detail view of the history.

You have to choose the version from the list of versions and click on the detail button. To restore the version click on the “Restore version”-button. You must have write access to the file if you want to restore a version.

![Figure 1.24: Restore a version](image1.png)

• **Publish a resource**

Resources can be published directly. They must be unlocked to enable the function in the context menu. Only members of the projectmanager and the administrator groups are allowed to publish resources of a project.

![Figure 1.25: Publish a resource](image2.png)

When a resource is published directly

- a temporary project is created
- the resource is copied to the new project
- the projectid of the resource and all its subresources is set to the new project
– the new project is published and deleted.

- **Copy a resource to the project**

A resource that does not belong to the current offline project is colored grey. You can copy this resource to the current offline project with this new feature in the context menu. Only the project manager and the administrator are allowed to copy resources to the project.

![Figure 1.26: Copy a resource to project](image)

You can also copy the parent resource of an already existing resource to the project, but it is not possible to copy the root folder to an existing project. For this you must create a new project.

### 1.3.4 Access permissions

On the user side, different access permissions determine which actions users can perform and which components they see, i.e. users see only those files and directories that are relevant to them. Doing this provides users with a well structured overview. Each user belongs to at least one user group, but can belong to several (Figure 1.27).

The following groups are pre-defined in OpenCms:

- **Administrators**: An administrator has full access permissions to all of the files and directories. Administrators create and manage users and user groups.

- **Project manager**: A project manager creates new projects and coordinates their workflow. A project manager’s access permissions are restricted to the projects he/she creates. A project manager can, however, access all of the files and directories within his/her projects. A project manager can also publish projects, i.e. put them online.
• **Users**: A user can create new files and directories within the project he/she is assigned to. As the owner, the user has full access permissions to the files and directories he/she creates.

• **Guest**: This group consists of all other users, such as visitors.

Based on the requirements, additional groups such as editors, designers, testers etc. can be created.

![Create new Group](image)

**Figure 1.27**: Create a new group

On the system side, each file and each directory is assigned to one user, which by default, is the user that created the file or directory, making him/her its owner. Each file and each directory is also assigned to one user group that has specific access permissions. This enables the users in this group to access the files and directories that are relevant to them. File and/or directory attributes, such as the owner of a file or directory, or the group assigned to the files, can only be modified by the administrator and/or the file and/or directory owner. All access permissions are maintained via the “Change owner”, “Change group” and “Change access permissions” options in the context menu. File and directory access permissions are classified by “Owner permissions”, “Group permissions” and “Other permissions.” A user’s access permission can be restricted to the files and directories that he/she owns. The following abbreviations are used to set a user’s permissions: r = read, w = write, v = visible, i = internal.
1.3.5 The editor

The editor is used to create content in the body, which is structured by a template that ensures that the layout for the navigator, the content and the individual pages - basically the layout for the whole site - is uniform (Figure 1.28):

![The HTML editor](image)

Figure 1.28: The HTML editor

The functionality of the OpenCms editor is very similar to that of a standard WYSIWYG HTML editor with templates, tables and preview functions, such as Netscape Composer. It is also possible to switch between sourcecode and WYSIWYG mode. A page’s layout is determined by a template. Complex layouts are created by cascading several templates. The editor in OpenCms is only used to edit the body of an HTML page.

1.3.6 Workflow

The project manager creates a new task and defines its role by clicking on the “New” button in the “Workflow” view. A role consists of several users that have the skills to perform a specific task such as editing, designing graphics, writing HTML code, etc. A preferred user is selected for each task. The name, the definition, the due date and the priority of the task as well as various messaging options are also defined. Depending on the selected messaging options, an e-mail is automatically sent to either the preferred user or all users that are assigned to a role as soon as a new task has been added to the project. The task is active once the appropriate user has accepted it. Optionally, the
CHAPTER 1. OPENCMS USER MANUAL

project manager receives an e-mail when the task has been accepted, rejected, forwarded or completed. Users can view the tasks that have been assigned to them as well as those they have forwarded to others by filtering on specific criteria in the drop-down menu “Filter” (Figure 1.29). Different icons and colors are also used to define a project’s status. A task that is still within the due date is shown in black. If the due date is exceeded, the task is shown in red. A completed task is shown in gray. A task’s priority is defined by icons (low, normal and high). The task descriptions provide a clear overview of a user’s task account.

![Figure 1.29: "workflow" view](image)

Clicking on the name of a new task displays its details and history. Each stage of the project is tracked and ensures that the workflow remains transparent.